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1 Setting Up
Congratulations on purchasing your new Macintosh Server G4. This chapter contains 
instructions for setting up your server and display. 

Positioning the Server and Display

You can pick up the server by any of its handles. If your monitor (or display) is heavy, be sure 
to use correct lifting techniques when positioning it. Position the server and display so that

m they are on sturdy, flat surfaces

m the power cable connectors don’t press against a wall or other object

m nothing obstructs air flow behind or below the display or server

m the server’s optical drive trays have space to open in front

Important  The only way to shut off power completely to your server and display is to 
disconnect their power plugs from the power source. Make sure the power cords for your 
server and display are within easy reach.
 5



       
Plugging In the Server

1 Plug the power cord firmly and completely into the recessed power socket marked with the 
symbol ≤ on the back of the server and plug the other end into a grounded outlet or 
power strip.

Power cord plug

Power cord socket
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2 Connect your display cables according to the following illustration: 

Your video card has these monitor ports:

m An Apple Display Connector (ADC) port to connect Apple flat-panel displays 

m A Digital Visual Interface (DVI) port to connect digital displays that have 
DVI connectors

m To connect a VGA monitor, use a DVI to VGA adapter (supplied with your computer) to 
connect the monitor to the DVI port 

m To connect a second ADC display, use a DVI to ADC adapter (not included) to connect the 
display to the DVI port.

Important  Depending on your monitor, you may have one or more cables to connect. 
Check the instructions that came with the monitor for further setup information.

USB ports

Monitor cableMonitor ports

DVI monitor portADC monitor port
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3 If required, connect your server to your Ethernet network or to your DSL or cable modem.

Ethernet port
8 Chapter  1  



    
4 Connect the keyboard cable to one of the USB ports ( ) on the server or on your display. 
Plug the mouse cable into a USB port on the keyboard.

If you wish, raise the keyboard by lifting it and flipping the foot toward the back. 

Keyboard Mouse

USB ports on keyboard (2)

Parts of your computer
may be covered by clear
plastic film that protected
it during shipment. You
can remove the film.

Don’t put anything in the recessed speaker opening except the
optional speaker grille. Touching the

speaker can damage it.
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5 Turn on your server by pressing the power button (®) on the front of the server. With some 
Apple displays, you can also turn on the server using the display’s power button.

m If your display must be turned on separately, turn it on by pressing its power button.

When the startup sequence is complete, the Mac OS X Server Setup Assistant opens.

6 Follow the onscreen instructions.

When you finish using the Setup Assistant, your server’s software and network settings will 
be configured automatically, based on the information you provided. 

Note:  Once you have used the Setup Assistant to configure your server, see the 
documentation provided with Mac OS X Server (Mac OS X Server Administrator’s Guide and 
Getting Started With Mac OS X Server) to find more information about configuring and using 
each of the services on your server.

Need Help?

If you don’t see anything on your screen or you think your server did not start up properly, 
check these items:

m Is the server plugged into a power source? If it is plugged into a power strip, is the power 
strip turned on?

m Are the keyboard and display cables connected correctly? 

m Is the power button lit on the front panel of the server and on the display? If not, the 
server or display isn’t receiving power.

m Is the display turned on? Are the brightness and contrast controls on the display adjusted 
correctly? If your display has brightness and contrast controls, adjust them.

m Restart your server. Press the server power button for approximately 5 seconds until the 
server turns off. Press it again to turn the server on.

m If you see a blinking question mark on the screen or hear a series of beeps when you turn 
on the server, see Chapter 4, “Troubleshooting,” on page 55.
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Turning Off the Server
m Choose Shut Down from the Apple (K) menu.

To turn the server on again, press the power button (®) on the server.

Adjusting Your Display

To adjust the settings for your display, choose System Preferences from the Apple (K) menu 
and click Displays.

For information about solving problems with your display, see “Problems With Your Display” 
on page 57. For information about maintaining your display, see “Maintaining Your Display” 
on page 68. Additional information about using your display is available in Mac Help. 

Warning  Do not use the power button or the switch on a power strip to turn the server 
off until after you have shut down your server properly. Your files or system software could 
be damaged if your server is not shut down properly.
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Getting to Know Your Server

Media Eject key

Optical drive

Speaker

Headphone
jack

Power button/
Status light

Optical bay
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Speaker

Use the recessed internal speaker to hear sound from the server. Take care not to let 
anything touch the fragile speaker mechanism. To protect the speaker from damage, a 
speaker grille is included with your server. However, you’ll receive better sound quality 
without the grille.

® Power button/Status light

Press this button to turn on the server or wake it from sleep. When the server is on, press 
the power button to put the server to sleep. A white light indicates that the server is on. A 
pulsing light indicates the server is in sleep. To restart your server, press and hold this 
button for approximately 5 seconds until the server turns off, then press it again to turn 
the server on.

With some Apple displays, you can also touch or press the monitor’s power button to turn 
the server on or put it to sleep.

f Headphone jack

Connect headphones to your server through the headphone jack.

Optical drive

Your server may have a Combo drive (DVD-ROM/CD-RW) or a SuperDrive (DVD-R/CD-RW). 
Both drives can read CD-ROM discs, Photo CDs, standard audio discs, and other kinds of 
media. They can also read DVD discs and DVD movies and write music, documents, and 
other digital files on CD-R and CD-RW discs. The SuperDrive can also write on blank DVD-R 
discs. To open the optical drive, press the Media Eject (C) key on your Apple Pro Keyboard.

Optical storage bay

Add a second optical drive to store and back up information. To open the second optical 
drive, press the Option key, then the Media Eject (C) key on your Apple Pro Keyboard.

C Media Eject key

Use the Media Eject key on the Apple Pro Keyboard to open the optical drive and eject CD 
and DVD discs.

With Mac OS X Server, you can also use the F12 key on some third-party keyboards to eject 
discs and open the top optical drive. When a second optical drive is installed, use the F12 
key and the Option key to eject discs and open the drive.
 Setting Up 13



   
Ports and Connectors—Expanding Your Server’s Capabilities

Lockable cover latch

Access covers for
expansion slots

DVI monitor port

Power socket

Ethernet port

ADC monitor port

USB ports (2)

FireWire ports (2) G

-

√

≤

Security lock portF

Audio line-out port

Audio line-in port

Apple speaker mini-jack
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Monitor ports

Connect your server to monitors that use an Apple Display Connector (ADC) or a Digital 
Visual Interface (DVI) connector. You can also connect your server to monitors that use a 
video graphics connector ( VGA) with the DVI to VGA adapter that came with your server.

USB ports

Connect your server to USB devices, such as keyboards, mouse devices, printers, scanners, 
speakers, USB microphones, and USB hubs. Your display may also have USB ports for 
connecting USB devices.

FireWire ports

Connect your server to FireWire devices, including digital video cameras, scanners, and 
hard disk drives. FireWire provides a high-speed method of data transfer between them all. 

Apple speaker mini-jack

Connect your server to high-fidelity Apple Pro speakers to play stereo music and sound for 
multimedia, games, audio CDs, and more. See “Adjusting the Sound Volume” on page 25 
for information about using your speakers. 

F Security lock port and lockable cover latch

Attach a security lock to your server and to its back panel to secure the internal 
components. When the lockable cover latch is pulled out, you can insert a security cable or 
lock to prevent the server cover from opening. See your server products retailer for 
security lock devices that will work with your server.

Access covers for PCI expansion slots (4)

Expand your Macintosh by installing up to four Peripheral Component Interconnect (PCI) 
cards in the covered slots, labeled 2, 3, 4, and 5. In some configurations, an Ultra160 low-
voltage differential (LVD) SCSI card is installed in one of these slots.

≤ Power socket

Connects to the server’s power cord.

G 10/100/1000 twisted-pair Ethernet port 

Connect your server to a high-speed Ethernet network to access the Internet or network 
resources, such as printers and servers, and share information over the network.

√ Audio line-in port

Connect self-powered microphones and other audio equipment to your server through 
the audio line-in port. 

_ Audio line-out port

Connect externally powered speakers or audio devices to your server through the audio 
line-out port.
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Inside Your Macintosh Server G4—Your Server’s Internal Expansion Options

Slot 1: AGP 4X slot
(graphics card installed)

DDR SDRAM slots (4)

Slots 2–5: 33 MHz
PCI slots (4)

(64-bit, 33 MHz)

Rear hard disk
drive carrier
(ATA/100 bus)

Front hard disk
drive carrier

(ATA/66 bus)

Optical drive carrier

Battery

AirPort Card connector
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Optical drive carrier

Install a second optical drive in the lower section of the optical drive carrier inside 
your server. 

Front hard disk drive carrier

Install additional hard disk drives in the front drive carrier inside your server. You can 
install up to two ATA/66 drives or up to two SCSI drives in the front carrier. 

Battery

Your server uses a battery that you rarely replace. If you find that your server is having 
trouble starting up, or that the system date and time are frequently incorrect, you may 
need to replace the battery. For more information, see “Replacing the Battery” on page 53.

AirPort Card connector

Connect an AirPort Card, which allows your server to communicate with a 
wireless network.

Rear hard disk drive carrier

Install additional hard disk drives in the rear drive carrier inside your server. You can install 
up to two ATA/100 drives or up to two SCSI drives in the rear carrier. 

DDR SDRAM slots

Expand your server’s memory up to 2 GB. Add additional memory in your server by 
inserting up to 4 DDR SDRAM DIMMs in the memory slots. 

AGP 4X graphics slot

Connect your monitor through the advanced graphics port (AGP 4X) card, which provides 
fast graphics processing power. You can connect a monitor that has an Apple Display 
Connector (ADC) or a Digital Visual Interface (DVI) connector. 

PCI expansion slots

Install up to four 64-bit, 33 MHz PCI cards in slots 2 through 5 to expand your server’s 
capabilities. 
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What’s Next?
m For more information about connecting to a network or using the server’s other 

hardware features, see Chapter 2, “Using Your Server,” on page 19.

m For information about installing additional drives, memory, or PCI cards or changing the 
server’s battery, see Chapter 3, “Working Inside Your Server,” on page 31.

m To register your new server with Apple, use the Setup Assistant. You can also register your 
server, Apple display, or Apple software on the Apple website at www.apple.com/register 
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2 Using Your Server

This chapter provides explanations and instructions for using the important features of your 
Macintosh Server G4, including your keyboard and mouse, FireWire ports, USB ports, and 
networking. 

Explanations are provided for

m “Using Your Apple Pro Keyboard and Apple Pro Mouse” on page 20

m “Using USB Devices” on page 22

m “Using FireWire Devices” on page 24

m “Using Your Optical Drive” on page 25

m “Using a Modem for PPP or Internet Access” on page 27

m “Connecting to an Ethernet Network” on page 27

m “Putting the Server and Network Services to Sleep” on page 29

m “Connecting SCSI Devices to Your Server” on page 29

m “Securing Your Server” on page 30
 19



Using Your Apple Pro Keyboard and Apple Pro Mouse

Your Apple Pro Keyboard comes with function keys preset for common tasks. Use the Media 
Eject key to eject optical discs from the top optical drive. When a second optical drive is 
installed, use the Media Eject key and the Option key to eject media from that drive. Press the 
Volume Up or Volume Down keys to adjust the sound level, or press the Mute key to turn 
sound off. You can also adjust an Apple display’s level of brightness with the Brightness Up 
and Brightness Down keys.

Note:  When you’re using a non-Apple keyboard with your server in Mac OS X Server, use 
the F12 key to eject optical discs from the top optical drive. Use the F12 key and the Option 
key to eject media from a second optical drive. 

Using Your Apple Pro Mouse

To position the pointer using your mouse, move the mouse over any suitable surface such as 
your desktop, mouse pad, or other textured surface. (Some smooth, glassy surfaces provide 
less pointer control than others.) To click an object, press down once on the mouse body 
until you feel a click. To double-click an item, press down twice in quick succession. 

Function keys

Volume Down key

Volume Up key-

Brightness Down key

Brightness Up key

Mute key—

Media Eject key

If you run out of room and want to
keep the mouse clicked while you
lift it, click the mouse, then squeeze
the sides with your thumb and
fingers as you lift.
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You can adjust the feel of your mouse by turning the dial underneath. Turning the dial one 
direction makes the feel of clicking the mouse stiffer; turning it the other way makes clicking 
the mouse easier. 

For More Information About Your Keyboard and Mouse

Additional information on configuring the keyboard controls and customizable function 
keys is available in Mac Help. Choose Mac Help from the Help menu and search for 
“keyboard” or “mouse.”

Turn the ring on the bottom of the mouse to “+” for more
tension, “O” for medium tension, and “–” for less tension.
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Using USB Devices

Your Macintosh Server G4 comes with two USB ports on the rear panel and your Apple Pro 
Keyboard also has two USB ports. You can use your USB ports to connect many types of 
external devices, including printers, digital cameras, microphones, game pads, joysticks, 
keyboards, mouse devices, and storage devices. USB makes it easy to connect external 
equipment. Once you connect the device, it is ready to use. You don’t need to restart your 
server. 

To use a USB device with your server, connect the device to the server and install its software 
or configure your server to work with the device. From then on, your server automatically 
loads the correct software whenever you attach the device. 

Note:  Apple has already included software to work with many USB devices. In most cases, 
you do not need to install the software that came with the device. If, when you connect a 
USB device, your Macintosh Server G4 cannot find the correct software, install the software 
that came with the device or download it from the manufacturer’s website.

USB ports (2)
22 Chapter  2  



Connecting Multiple USB Devices

Your Macintosh Server G4 has two USB ports on the rear panel. Your keyboard or monitor 
may also have ports that you can use to connect devices. If you want to connect more 
devices, you can purchase a USB hub. The USB hub connects to an open port on your server 
and provides additional USB ports (usually four or seven). 

For More Information on USB

Additional information on USB is available in Mac Help. Choose Mac Help from the Help 
menu and search for “USB.” You can also find information on Apple’s USB website at 
www.apple.com/usb 

For information on USB devices available for your server, go to the Macintosh Products 
Guide at www.apple.com/guide 

USB hub
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Using FireWire Devices

Your server has two FireWire ports. FireWire is a high-speed data transfer system that lets you 
easily connect and disconnect external devices, such as printers and hard disks. You can 
connect and disconnect FireWire devices without restarting your server. 

You can connect an external FireWire hard disk drive and use it to back up data or transfer 
files. If you have installed software for your FireWire hard disk, the FireWire disk icon 
automatically appears on your desktop after you connect the disk drive to your server. Some 
FireWire hard disks get their power through the FireWire cable, so you don’t need to connect 
an external power supply.

To use a FireWire device with your Macintosh Server G4, connect the device to the server and 
install any software that came with the device. Your server automatically detects when you 
attach a new device. 

To start up from a FireWire hard disk that has Mac OS X Server on it, use the Startup Disk 
pane of System Preferences to select the FireWire hard disk as the startup disk. If your 
FireWire hard disk doesn’t appear or can’t be selected, consult the FireWire hard disk vendor 
for updated software drivers.

For More Information on FireWire

Additional information on FireWire, including setting up a network of FireWire devices, is 
available in Mac Help. Choose Mac Help from the Help menu and search for “FireWire.” You 
can also find information on Apple’s FireWire website at www.apple.com/firewire

For information on the FireWire devices available for your server, go to the Macintosh 
Products Guide at www.apple.com/guide 

FireWire ports (2)
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Using Your Optical Drive

You can install or run software from CDs using your optical drive. You can play multimedia on 
CD discs and music from audio CDs. Your optical drive can also write music, documents, and 
other digital files on CD-R and CD-RW discs. If you have a Combo drive (DVD-ROM/CD-RW ) 
or a SuperDrive (DVD-R/CD-RW ), you can also play DVD movies and use most DVD discs. 
SuperDrives can also record information on blank DVD-R (recordable DVD) discs. 

Note:  If you have older software that comes on floppy disks, contact the software 
manufacturer to see if the software is available on a CD or purchase an external USB 
floppy disk drive for your Macintosh Server G4 from your Apple dealer or the Apple Store 
(www.apple.com/store).

Inserting a Disc

To install or use programs from a CD or DVD, follow these steps:

1 With the server turned on, press the Media Eject (C) key on your Apple Pro Keyboard to 
open the drive.

2 Place a disc in the tray, with the label facing up, and make sure the disc is lying flat.

3 Press the Media Eject (C) key again or gently push the tray in to close it. 

When the icon for the disc appears on the screen, the disc is ready to use.

Ejecting a Disc

You can eject a disc by dragging the disc icon to the Trash, or by pressing the Media Eject (C) 
key on your Apple Pro Keyboard. When a second optical drive is installed, you can eject a disc 
from it by pressing the Option key and the Media Eject (C) key. You can also eject a disc by 
holding down the mouse button while restarting your server.

Adjusting the Sound Volume

To adjust the sound volume, repeatedly press the volume keys (-, –) on your keyboard. 
You can also adjust speaker volume and balance from your server by choosing System 
Preferences from the Apple (K) menu and clicking Sound. 

Note:  If you do not want the internal speaker to output sound when you attach Apple Pro 
speakers, headphones, or other audio devices to your server, choose System Preferences 
from the Apple (K) menu and click Sound.
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Recording Information on a CD

Your optical drive can record programs and files on CD-R and CD-RW discs. Create your own 
music CDs and play them in any standard audio player. You can also record server files, such 
as applications, documents, or other digital files, on a recordable CD. 

With a CD-R (CD-Recordable) disc, you can record information on the disc once. Although 
you can’t change the recorded information, you may be able to add more information until 
the disc is full, depending on the application you use. See the documentation that came 
with your application for specific information about recording on your CD-R disc. It is best 
to use CD-R discs for recording audio CDs, because your audio CD player may not read 
CD-RW discs.

With a CD-RW (CD-Rewritable) disc, you can save and change information on your CD 
multiple times. However, some software for recording media files on CDs can record data on 
the disc only once.

You can copy data on CD-R discs with Disc Burner.

1 Insert a blank CD-R disc in the optical drive.

2 In the dialog box that appears, enter a name for the disc and select the format you want to 
create. An icon for the CD appears on the desktop.

3 Double-click the CD icon, then drag files and folders to it.

4 Choose Burn Disc from the File menu or select the disc and drag it to the Burn Disc icon in 
the Dock in Mac OS X Server.

Recording Information on a DVD

If you have a SuperDrive, you can record digital data, such as backing up files onto DVD-R 
discs. However, once you record information on a DVD-R disc, it cannot be overwritten.

You can record data on DVD-R discs in Mac OS X Server with Disc Burner.

1 Insert a blank DVD-R disc in the drive.

2 In the dialog box that appears, enter a name for the disc and select the format you want to 
create. An icon for the DVD appears on the desktop.

3 Double-click the DVD icon, then drag files and folders to it.

4 Choose Burn Disc from the File menu or select the disc and drag it to the Burn Disc icon in 
the Dock in Mac OS X Server.
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Using a Modem for PPP or Internet Access

To connect an external USB modem, use a USB cable to connect the modem to an available 
USB port on the keyboard, server, USB monitor, or USB hub.

Check the documentation that came with the modem to see if it needs to be plugged into a 
power outlet. Also look for instructions about installing modem software and connecting the 
modem to a telephone line.

Connecting to an Ethernet Network

Your server comes with built-in 10/100/1000 megabit per second (Mbps) twisted-pair 
Ethernet networking capability.

If you’re connecting to an existing network, you may be able to get information about the 
network and the network software you need from a network administrator who oversees its 
operation. Identify your organization’s network administrator before you begin.

Follow these guidelines when selecting a cable for your network:

Connecting to a Twisted-Pair Ethernet Network

You can connect directly to a 10/100/1000 twisted-pair Ethernet network.

Note:  You can also connect your server to an Ethernet network that uses thin coaxial cables. 
To do this, you need an RJ-45–to–Thin Coax adapter (available from other manufacturers). 
See your Apple-authorized dealer for more information on Ethernet media adapters.

To connect your Macintosh to a centralized 10/100/1000 twisted-pair Ethernet network, 
follow these steps:

1 Plug one end of an RJ-45 twisted-pair cable into the Ethernet port on your Macintosh.

Type of twisted-pair Ethernet Use twisted-pair cable types

10 Mbps Category 3, 5, or 6

100/1000 Mbps Category 5 or 6
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2 Plug the other end of the cord into an RJ-45 wall outlet or external hub that is connected to a 
twisted-pair Ethernet network.

After you start up the server, you need to configure the software for your network 
connection. Your network administrator can provide the necessary information. You can also 
get help configuring your network software using Mac Help (in the Help menu). For 
information on networking products you can use with your Macintosh Server G4, go to the 
Macintosh Products Guide at www.apple.com/guide 

Maximizing Ethernet Performance

Your server performs best when the Ethernet port to which it is attached is set to auto-
negotiate. Work with your network administrator to verify this setting.

If you connect your server directly to a configurable Ethernet switch, have your network 
administrator disable spanning tree on that port. Otherwise your server may duplicate the 
AppleTalk address of another computer on the same network and both network connections 
may become unreliable.

Ethernet port
(Twisted-pair
Ethernet)

RJ-45 wall plate

Twisted-pair Ethernet cable

Ethernet hub
or switch

Important  The duplex mode of an Ethernet link to a switch is not detected if the switch’s 
port is not auto-negotiating. Your server detects the appropriate speed but defaults to half-
duplex. If the switch’s port at the other end of the link is configured for full-duplex, a large 
number of late events can occur on the link. Set the switch’s port to auto-negotiate where 
possible. If this isn’t possible, then set the switch’s port to half-duplex. For more information, 
see the documentation that came with the Ethernet hub.
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For More Information on Using Ethernet

Additional information, including setting up an Ethernet network or transferring files using 
Ethernet, is available in Mac Help. Choose Mac Help from the Help menu and search for 
“Ethernet” or “network.” 

For information on networking products you can use with your Macintosh Server G4, go to 
the Macintosh Products Guide at www.apple.com/guide

Putting the Server and Network Services to Sleep

For best performance, your server’s Energy Saver System Preferences are set so that the 
server never sleeps. When the server is in sleep, network services are inaccessible and server 
software cannot work. You can set the server to sleep after a certain period of inactivity, but 
this is not recommended for server applications. Sleep is a state in which your server uses 
very little power. If you would like to minimize power consumption but keep server software 
and services available, use a screen saver program or turn off your monitor.

When the server is in sleep, the power button light on the front panel pulses. You wake the 
server by pressing the power button on the front panel of the server or by pressing a key on 
the keyboard. With some Apple monitors, you can also use the monitor power button to put 
the server to sleep and wake it.

For more information about putting your server to sleep and other energy-saving options, 
see Mac Help.

Connecting SCSI Devices to Your Server

Some Macintosh Server G4 configurations come with an Ultra160 Dual Channel SCSI card 
installed in a PCI slot with one or more internal SCSI hard disks connected to it. You can 
install additional internal SCSI hard disk drives, up to a maximum of four drives. It’s 
recommended that you only connect SCSI Ultra160 LVD hard disk drives to the internal port 
of the Dual Channel SCSI card. You can connect external SCSI devices, including older drives 
with slower data transfer rates, to the external port of the Ultra160 Dual Channel SCSI card. 
Because the card has two channels, one connected to the internal port and another 
connected to the external port, connecting older devices to the external port doesn’t slow 
down the transfer rate of the internal hard disk drives. 

Apple recommends that you use only SCSI Ultra160 LVD devices as internal hard disk drives.

To connect older SCSI devices that use a 25-pin or a 50-pin connector—such as Zip drives, 
scanners, or DAT drives—you need to purchase SCSI adapters, or purchase and install an 
additional “legacy” SCSI PCI card (one that supports older devices).
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For more information about using different types of SCSI devices with your server, go to the 
AppleCare Service and Support website at www.apple.com/support

Securing Your Server

Attach a locking cable to the server if required. Follow the instructions supplied with the 
locking cable to secure it to your server. When you install the locking cable, feed the cable 
through the lockable latch on the cover to prevent memory, disk drives, and expansion cards 
from being removed. You can use the locking mechanism to secure your keyboard, mouse, 
or Apple Pro speakers.

Security cables that connect to the built-in security lock port are available from other 
manufacturers. See your Apple-authorized dealer for more information.
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3 Working Inside Your Server

This chapter provides information and instructions for working inside your server. 

Instructions are provided for the following procedures:

m “Opening the Server” on page 32

m “Installing Memory” on page 34

m “Installing Internal Storage Devices” on page 36

m “Installing a PCI Expansion Card or Replacing the AGP Card” on page 50

m “Replacing the Battery” on page 53

Warning  Apple recommends that you have an Apple-certified technician install memory, 
PCI expansion cards, and internal storage devices. Consult the service and support 
information that came with your server for instructions on how to contact an Apple-
authorized service provider or Apple for service. If you install these items yourself, you 
risk damaging your equipment, and such damage is not covered by the limited warranty 
on your server. See an Apple-authorized dealer or service provider for additional 
information about this or any other warranty question.
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Opening the Server

1 Before you open your server, shut it down by choosing Shut Down from the Apple (K) 
menu. 

2 Unplug all the cables from the server except the power cord.

3 Touch the metal PCI access covers on the back of the server to discharge any static charge.

4 Unplug the power cord.

Warning  Always shut down your Macintosh Server G4 before opening it to avoid damaging 
its internal components or the components you want to install. Do not open the server or 
attempt to install items inside it while it is turned on. After shutting down your server, the 
internal components can be very hot. Let the server cool down before continuing. 

Touch the metal
portion of the PCI
port access covers.

Important  Always do this before you touch any parts, or install any components, inside 
the server. To avoid generating static electricity, do not walk around the room until you 
have finished installing the expansion card, memory, or internal storage device and closed 
the server.

Warning  The power supply in your server is a high-voltage component and should not 
be opened for any reason, even when the server is off. If the power supply needs service, 
contact your Apple-authorized dealer or service provider.
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5 Lift the latch on the side of the server. 

Note:  If the latch won’t lift, check that the security lock port and lockable cover latch in the 
back of the server are not locked.

6 Gently lower the side panel onto a clean, flat surface, preferably onto a soft, clean cloth.

Lift the latch to unlock
the side panel.

Gently lower the side
panel until it lies flat.
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Installing Memory

Your server uses Double-Data-Rate (DDR) Synchronous Dynamic Random-Access Memory 
(SDRAM) in packages called Dual Inline Memory Modules (DIMM). You can install additional 
DIMMs in the four DDR SDRAM slots on your server’s main logic board, up to a maximum of 
2 gigabytes. 

DIMMs must fit these specifications: 

m PC 2700 DIMMs

m 2.5 volt ( V )

m 64-bit wide, 184-pin module

m Maximum number of memory devices on DDR SDRAM is 16.

m Non parity

m No error correcting codes (ECC)

m Unbuffered; do not use registered or buffered DDR SDRAM.

If you install 512 MB DDR SDRAM, it must have 256 megabit (Mbit) devices. You can also 
install 256 MB DDR SDRAM that has 256 Mbit or 128 Mbit devices. You can install different 
DDR SDRAM DIMMs in any order in any memory slot. To check the compatibility of your 
DDR SDRAM, see the Macintosh Products Guide on Apple’s website at www.apple.com/guide 

Note:  When purchasing DDR SDRAM for use in Macintosh servers, make sure that the 
memory vendor conforms to the JEDEC specification. Check with your memory vendor to 
ensure that the DDR SDRAM supports the correct timing modes and that the Serial Presence 
Detect (SPD) feature has been programmed properly, as described in the JEDEC 
specification. You can purchase Apple-branded memory online from the Apple Store at 
store.apple.com 

Important  SDRAM from older Macintosh servers is not compatible with your Macintosh 
Server G4. Do not use older SDRAM, even if it fits into the DDR SDRAM slots.
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1 Open the ejectors on the DDR SDRAM slots you want to use by pushing down on them.

2 Align the SDRAM in the slot and push both ends of the SDRAM down until the tabs are 
vertical and the ejectors snap into place. Close the server.  

Important  Do not touch the SDRAM connectors. Handle the SDRAM only by the edges.

SDRAM DIMM (Your DIMM’s shape and components may vary.)

The SDRAM DIMM is designed to fit into
the slot only one way. Be sure to align the
notch in the DIMM with the small rib
inside the slot. With the ejectors in the
open position (as shown), push down
on the DIMM until it snaps into place.
The ejectors will automatically close. 

Connectors Notch SDRAM slot (1 of 4)

Ejectors
(They should be pushed outward and down
to be in the open position, as shown.) Rib (inside slot)
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Installing Internal Storage Devices

Your Macintosh has six internal drive bays:  two optical drive bays and two hard drive bays in 
the front, and two hard drive bays in the rear. In many configurations, a single hard disk drive 
occupies the rear bay. One of the upper front bays contains an optical drive, and you can 
purchase and install a second optical drive in the lower bay. 

You can add SCSI or ATA disk drives to the empty front and rear drive bays. 

The drives must meet these specifications:

m Width:  3.9 inches (102 mm)

m Depth:  5.7 inches (147 mm)

m Height:  1.0 inch

The server provides support for the following types of internal storage devices: 

m Ultra ATA/100 devices (in rear bay only)

m Ultra ATA/66 devices

m Ultra ATA devices

m ATA devices, including ATA, ATA-2, ATA-3, up to ATA-6 devices

m ATAPI drives, including SuperDrive (combination DVD-R and CD-RW drive), Combo drive 
(combination DVD-ROM and CD-RW drive), CD-RW, DVD-ROM, and DVD-R drives

m Wide Ultra, Ultra2, and Ultra160 low-voltage differential (LVD) SCSI devices (these devices 
require a SCSI PCI card)

For more information about requirements and devices supported, see your Apple-authorized 
dealer and the support section of Apple’s website:  www.apple.com/support

Important  Your server works with ATA and ATAPI internal storage devices that are set for 
cable select mode. Because cable select mode forces the drive to set its ID based upon its 
position on the cable, hard drives and optical drives are easily configured. Before you install 
an additional ATA and ATAPI drive, check the documentation that came with your drive or 
with the manufacturer to make sure it is set for cable select mode.

Important  Use the original Apple cables that came with your server when you install 
additional drives. Some non-Apple cables may not correctly support cable select mode.
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Installing Ultra ATA Drives

Your Macintosh Server G4 can accommodate two internal 1-inch-high ATA devices in each 
hard drive carrier, for a total of four drives. If your server has one Ultra ATA drive installed, it 
sits in the rear drive carrier. You can install a second ATA drive in the rear carrier and two 
additional ATA drives in the front carrier. 

Note:  Contact your drive manufacturer or consult the manufacturer’s website to determine 
if your drive is set for cable select mode. Before installation, set the drive to cable select if the 
manufacturer hasn’t already done so.

ATA hard disk drives
(ATA/66 bus)

ATA hard disk drives
(ATA/100 bus)
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To install an additional Ultra ATA drive in the rear carrier:

1 Pull the plastic tab on the drive carrier away from the server’s chassis.

2 Lift the drive carrier up slightly to access the cables.

3 Release the cable from the clamp.

Pull this tab away from the
chassis wall to unlock the
drive carrier, and slide the
carrier up a short distance.
Gently pull the drive carrier
away from the chassis so
that you can access the
hard drive cables.

Release the ribbon cable
from the cable clamp.
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4 Pull the carrier free and continue to hold it while you remove the power and ribbon cables 
from any installed drive. 

While holding
the drive carrier
assembly, carefully
remove the ribbon
cable and power
cable from the
hard disk drive.
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5 Install the second ATA drive in the drive carrier and screw it into position.

Attach an additional ATA drive (up to 1" high)
to the open portion of the drive carrier by 

screwing it into position on its sides.

Position the hard disk drive on the drive
carrier so that the ribbon cable connector
and the power cord connector are accessible.

There are four extra screws stored on the outside of the drive carrier.
You can use these screws if your second hard disk drive didn’t
come with any. If it did come with
screws, use those.
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6 Attach the power and ribbon cables to the drives. 

While holding
the drive carrier
assembly, attach
the ribbon cable
and power cable
to both hard disk
drives.
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7 Replace the drive carrier on the chassis, pushing gently until it locks into position.

8 Secure the ribbon cable with the cable clamp.

9 Close the server.

Reinstall the drive
carrier by aligning
the three pins on
the back of the carrier
with the guides inside the
chassis. Push down
on the carrier until
it locks into position.

Secure the ribbon cable
with the cable clamp. 
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To install an additional Ultra ATA drive in the front carrier:

1 Release the ribbon cable from the cable clamp.

2 Remove the power and ribbon cables from any installed drive.

3 Slide the drive carrier away from the chassis.

4 Install the ATA drive in the drive carrier and screw it into position. 

Note:  Contact your drive manufacturer or consult the manufacturer’s website to determine 
if your drive is set for cable select mode. Before installation, set the drive to cable select if the 
manufacturer hasn’t already done so.

If necessary, remove
the ribbon and power
cables from any hard
disk drives already
installed in the carrier.
Then press down on the
tab located on the side
of the carrier, and slide
the drive carrier out.
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5 Replace the drive carrier by aligning the pins on the guide slots and gently pushing 
the assembly.

Reinstall the drive carrier
assembly. Align these
pins with the three guide
slots in the chassis and
push the assembly in
until it clicks into place.
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6 Attach the ribbon and power cables.

7 Secure the ribbon cable with the cable clamp.

8 Close the server. 

Secure the ribbon cable
with the cable clamp.

Attach the ribbon and
power cord to the hard
disk drive(s).
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Installing Ultra160 LVD SCSI Drives

If your Macintosh has an internal Ultra160 LVD SCSI drive, you can connect up to three more 
internal Ultra160 LVD SCSI drives to the PCI card and cable inside the server—for a total of 
four SCSI drives. This cable has the required connectors and a built-in terminator, so you 
don’t need to add one.

Note:  If your server doesn’t have a SCSI hard disk drive, you need to install a SCSI PCI card 
in your server to connect SCSI hard disk drives. 

SCSI ribbon cable

SCSI terminator

PCI SCSI card
The ribbon cable may attach
to a different position on the PCI SCSI
card, depending on the card you have. 

Make sure all of the power
cord and ribbon cable
connectors are firmly attached
to all of the drives and to the
PCI SCSI card.
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The procedures for disconnecting and connecting a SCSI hard disk drive and for removing 
and inserting drive carriers are nearly identical to those presented in the ATA drive installation 
instructions on page 37. Follow the ATA drive instructions when installing a SCSI drive. 

However, before installing your SCSI drive, note the following difference:

When you configure your SCSI hard disk drive

Assign a unique SCSI ID number to each new device. A single factory-installed drive uses 
SCSI ID 0; a second factory-installed drive uses SCSI ID 1; a third factory-installed drive uses 
SCSI ID 2; and a fourth factory-installed drive uses SCSI ID 3. The SCSI PCI card has been 
assigned ID 7. If you select one of these numbers for a new drive, the drive will not work 
properly.

Installing Optical Drives

You can install a second optical drive in the lower optical drive bay.

1 Slide the metal shield away from the optical drive carrier.

2 Remove the power and ribbon cables.

3 Remove the two attachment screws from the optical drive carrier and put them 
in a safe place.

Note:  The drive carrier screws are located on the back side of the carrier.

Slide the metal shield
away from the optical
drive carrier.

Detach the power
cable and ribbon cable
from the optical drive.
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4 Slide the carrier back and remove it from the server. 

5 Install the second optical drive in the drive carrier and screw it into position. 

Slide the carrier back a
short distance until it
disengages from the
chassis, then remove
the carrier from the 
computer.

Unscrew these two screws from
the optical drive carrier. Depending
on your computer model, the screws
may or may not come out completely.

Slide the optical drive
into the drive carrier.

There are four extra screws stored on the outside of the drive
carrier. You can use these screws if your second optical drive
didn’t come with any. If it did come with screws, use those.

Screw the optical drive in place with four screws.
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6 Replace the drive carrier in the chassis and reinsert the screws. 

7 Attach the power and ribbon cables to the drives.

8 Replace the metal shield, taking care not to crimp the cables.

9 Close the server.

Reinstall the optical drive carrier in the computer. Make sure this guide
engages the slot in the chassis. Push the carrier forward until it is firmly
seated, and then tighten the two screws.

Reinstall the metal shield. Make sure it
engages these guides. Be careful not
to crimp or abrade any cables.

Attach the power cables and ribbon
cables to the optical drives. The end
connectors on the cables attach
to the top drive, and the middle
connectors attach to the bottom drive.
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Installing a PCI Expansion Card or Replacing the AGP Card

You can expand the capabilities of your Macintosh Server G4 by installing cards in its expansion 
slots. The server has five expansion card slots, four of which accommodate Peripheral 
Component Interconnect (PCI) cards and one that accepts an advanced graphics port 
(AGP) card.

AGP cards and PCI cards have different connectors, so you cannot insert a PCI card into the 
AGP slot.

About AGP Cards

Your AGP card, installed in slot 1, contains the graphics processor unit (GPU) and provides 
the computer’s monitor ports. Slot 1 is designed specifically to accept AGP cards. This 66 
megahertz (MHz) slot accommodates 1.5 volt ( V ) AGP cards (see the illustration on 
page 51).

You can replace the card that came with the server with an AGP 4X card. A replacement AGP 
card must have a driver compatible with the Mac OS.

About PCI Expansion Cards

Your Macintosh has four expansion slots, labeled 2, 3, 4, and 5, which accept PCI cards up 
to 12 inches long. Some models come with a SCSI PCI card installed in one of these slots. 
Install only expansion cards that come with Macintosh driver software and that comply with 
the PCI 2.1 standard.

The PCI slots can accommodate mixed voltage (5.0 V, 12 V, or 3.3 V ) cards with 32-bit or 
64-bit data widths and a 33 MHz frequency. You can add a 66 MHz card to a PCI slot if the 
card can operate at the lower 33 MHz rate.

Maximum power consumption for all five expansion slots (the four PCI expansion cards and 
the AGP card) should not exceed 90 watts ( W ). 

Warning  Do not use cards that function only at 66 MHz in the PCI slots. Damage to your 
equipment could result. If you have a 66 MHz card, check the card’s manufacturer to see 
if it also works at 33 MHz.
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Installing Your Card

Install an AGP card in slot 1 only. Install PCI expansion cards in the slots labeled PCI 2, 3, 4, 
and 5.

1 Remove the screw that holds the port access cover in place, pull out the access cover, and set 
it aside.

m To remove a card that’s installed in the server, remove the screw that holds the card in 
place and pull the card from the slot.

Warning  Cables with large connectors may interfere with the enclosure in the PCI slot 
numbered 5, making it difficult to close the door and potentially causing damage to your 
PCI card. If this is the case, rearrange the cards in the slots. You may also connect the 
cable after the enclosure door is shut, but be sure to remove the cable before opening the 
door again. If your PCI cards are connected to each other with cables or jumpers, take 
care when closing the door.

Port access cover

Remove the screw that
holds the port access
cover in place.

If you need to
remove the card in
the AGP slot, press
this tab to release the catch.
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2 Remove the card that you want to install from its static-proof bag and hold it by its corners, 
taking care not to touch the gold connector or any of the components on the card.

3 Align the card’s connector with the expansion slot and press down until the connector is 
inserted all the way into the slot.

If you’re installing a 12-inch card, make sure the card engages the appropriate guide at the 
front of the server.

Press the card gently but firmly until the connector is fully inserted.

m Don’t rock the card from side to side; instead, press the card straight into the slot. 

m Don’t force the card. If you meet a lot of resistance, pull the card out. Check the 
connector and the slot for damage or obstructions, then try inserting the card again.

m Pull the card gently to see if it is properly connected. If it resists and stays in place, and if 
its gold connectors are barely visible, the card is connected. 

Port access
opening

PCI slot

Reinstall the screw
to secure the
card in place.

If the PCI card you
are installing is full-length
(12 inches), make sure it fits
in one of these four card guides.
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4 Reinsert the port access cover screw and tighten it to hold the card in place.

5 Close the server.

Replacing the Battery

Your server has a 3.6 V lithium battery on the main logic board. If your server has 
intermittent problems starting up or random changes in its date and time settings, you may 
need to replace the battery. Purchase a replacement battery from an Apple-authorized dealer.

Warning  If you removed a card from your server and did not install a replacement, be 
sure to place a port access cover over the empty slot. Do not leave an empty slot without 
a cover. Covers keep foreign objects out of the enclosure. An uncovered slot can affect the 
air flow that cools the server’s internal components and cause damage.
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1 Remove the battery from its holder, noting the orientation of the battery’s positive end. (A 
plus sign is marked on and near the battery holder.)

2 If necessary, carefully spread the tabs holding the battery so you can remove it.

3 Insert the new battery in the holder, making sure the battery’s positive symbol aligns with 
the positive symbol on or near the holder.

4 Close the server.

Important  Batteries contain chemicals, some of which may be harmful to the environment. 
Please dispose of used batteries according to your local environmental laws and guidelines.

Remove the battery by pulling it
up and out of its holder. You may
need to spread these two tabs
slightly apart to release the battery.
Spread the tabs gently so they
don’t break.

Warning  Installing the battery incorrectly may cause an explosion. Be sure the battery’s 
positive and negative poles are correctly oriented in the holder. Use only the same type of 
battery or an equivalent recommended by the manufacturer of the original.
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4 Troubleshooting 

If you have a problem while working with your server, here are some things you can try 
right away. 

If the server won’t respond or the pointer won’t move:

First, make sure the mouse and keyboard are connected.

m Unplug and then plug in the connectors and make sure they are firmly seated.

Then try to cancel what the server is doing.

m Press the Command (x) and Q keys at the same time to try to quit the current application. 

m Choose Force Quit from the Apple (K) menu and select the application you would like to 
quit. Restart the server by choosing Restart from the Apple (K) menu to be sure the 
problem is entirely cleared up. 

m Press the Esc, Option, and Command (x) keys at the same time. If a dialog box appears, 
click Force Quit. Restart the server by choosing Restart from the Apple (K) menu to be 
sure the problem is entirely cleared up. 

m If the problem occurs only when you use a particular program, check with the 
program’s manufacturer to see if it is compatible with your server.

m If the problem occurs frequently, choose Mac Help from the Help menu and search for 
information on preventing and solving problems. You may also need to check for 
extension conflicts or reinstall your server’s system software.
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If the server won’t turn on or start up:

First, make sure the power cord is connected to a working power source.

m The plug on the power cord must be completely inserted into the server’s power socket 
and firmly seated for your server to operate correctly.

Reset the server’s parameter random-access memory (PRAM).

m Start up the server and immediately hold down the Command (x), Option, P, and R keys 
until you hear the startup sound a second time. Then select your hard disk as the server’s 
startup disk using the Startup Disk pane in your server’s System Preferences.

If you hear tones during startup: 

m If you recently installed additional memory, a PCI expansion card, or another internal 
component, make sure that it is correctly installed and that it is compatible with your 
server. See if removing it allows the server to start up.

m Contact an Apple-authorized service provider.

If you are unable to eject a disc:

m A file on the disc may be in use. Quit applications that are open, then try again.

m If that doesn’t work, choose Restart from the Apple (K) menu and hold down either the 
mouse button or the Media Eject (C) key on your Apple Pro Keyboard.

m Select the disc in the Finder and press the Command (x) and E keys at the same time.

Software Problems

If you have a problem with a software program:

m Use Software Update to ensure that you have the latest drivers, bug fixes, and other 
updates.

m For problems with software from a manufacturer other than Apple, contact the 
manufacturer.

If you have a problem using your server or working with the Mac OS: 

m Look in the Help Center (in the Help menu) for instructions and troubleshooting 
information.

m Look in the Mac OS X Server Administrator’s Guide (in PDF format) that came with 
your server.

m Go to the Apple Support website on the Internet for the latest troubleshooting 
information and software updates:  www.apple.com/support
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Problems With Your Display

No image appears on the screen.

m Make sure the display and server are turned on.

m Make sure the cables are connected properly to your server and the display.

m Make sure your server is not in sleep. Press the power button or any key to see if the 
server wakes. 

m Make sure the display brightness and contrast are set properly. Some monitors have 
brightness and contrast controls on or under their front edge.

The screen image appears dim or flickers.

m Adjust the display brightness and contrast settings. Some displays have brightness and 
contrast controls on or under their front edge. Depending on how dim your monitor 
appears, you may be able to adjust brightness or contrast using the Displays pane in your 
server’s System Preferences.

m Calibrate the monitor using the Calibrate button in the Displays pane of System Preferences.

m The flickering may be caused by interference from a nearby power line, a fluorescent 
light, or an electrical device—for example, a radio, a microwave oven, or another server. 
Try relocating nearby electrical devices or moving your server and display.

No colors appear on the screen or the colors don’t look right.

m Make sure the display is connected firmly to the server.

m You may want to calibrate your monitor using the Displays pane in your server’s 
System Preferences. For more information on color and your display, see Mac Help.

m Click the Display tab in the Displays pane of System Preferences and make sure your 
monitor is set to display colors. For more information on color and your display, see 
Mac Help.

After you change the screen resolution, desktop icons move.

m Changing the screen resolution affects the display of information on your screen. The 
operating system may reposition icons after you change the screen resolution.

Warning   If you have a problem with your Apple display and nothing presented in this 
manual solves it, contact an Apple-authorized service provider or Apple for assistance. 
If you attempt to repair the display yourself, any damage you may cause to the display 
will not be covered by the limited warranty on your display. Contact an Apple-authorized 
dealer or service provider for additional information about this or any other warranty 
question.
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The light on the front of the display is flashing.

On some Apple flat-panel displays, the power light can display a series of short flashes when 
an error has been detected. 

m If you see a repeating sequence of three short flashes, the monitor is detecting input in 
the wrong video format. Check that your monitor is compatible with your graphics card 
and that you’ve installed the correct display software, if your monitor came with 
installation software. 

m If you see a sequence of two short flashes and a long flash, the monitor is detecting a 
problem with a backlighting lamp. Contact an Apple-authorized dealer or service provider. 

Reinstalling Your Server’s Software

If you are having problems with the system software or applications that came with your 
server and you want your server to have its original system software, factory settings, and 
applications, you can use the Mac OS X Server Installation CD that came with your server. Be 
sure to back up all your software files before reinstalling.

Before Reinstalling Your Software

Before you reinstall your software, note any preferences or settings in System Preferences 
and applications so you can easily reset them after you reinstall your software. Use Disk 
Utility, located in the Utilities folder inside the Applications folder on your hard disk, to 
repartition your hard drive before you reinstall your software.

Follow these instructions to reinstall Mac OS X Server directly on a server with a display and 
a keyboard.

To install Mac OS X Server:

1 Turn on the server and insert the Mac OS X Server Installation CD that came with your server:

2 Restart the server from the CD (hold down the C key on the keyboard while you restart the 
server).

3 Follow the onscreen instructions to install the software.

4 When the server restarts, the Server Assistant opens so you can finish basic setup.

Important  It is highly recommended that you back up the data on your hard disk before 
reinstalling software. Apple is not responsible for any lost data.
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A Specifications

Processor and Memory Specifications 

Processor

m PowerPC™ G4 processors with 256 kilobytes (KB) on-chip cache

m Some configurations have L3 backside cache memory.

Random-access memory (RAM)

m Double-Data-Rate (DDR) Synchronous Dynamic Random-Access Memory (SDRAM) up to 
a maximum of 2 gigabytes (GB).

m All DDR SDRAM is supplied in removable Dual Inline Memory Modules (DIMMs).

m Four slots are available for PC 2700 DDR SDRAM

m 128, 256, or 512 megabyte (MB) DIMMs

256 MB DIMMs must have 128 or 256 megabit (Mbit) technology devices; 512 MB DIMMs 
must have 256 Mbit technology devices.

m 2.5 volt ( V ) unbuffered, 64-bit wide, 184-pin

m Non error correcting (ECC)

m Non parity

Apple System Profiler, located in the Utilities folder in the server’s Applications folder, 
provides information about your server, including the amount of memory.
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Dimensions and Operating Environment 

Dimensions

m Weight:  19.05 kg, 42 lbs.

Weight depends on configuration. Weight above includes basic configuration:  one optical 
and one hard disk drive. Weight may be greater if optional devices are installed.

m Height:  432 mm, 17.0 in.

m Width:  227 mm, 8.9 in.

m Depth:  468 mm, 18.4 in.

Operating environment

m Operating temperature:  10° to 35° C (50° to 95° F)

m Storage temperature:  –40° to 47° C (–40° to 116.6° F)

m Relative humidity:  5% to 95% (noncondensing)

m Altitude:  0 to 3048 meters (0 to 10,000 feet)

Combo Drive (DVD-ROM/CD-RW) Specifications

m Disc diameters supported:  12 cm (4.7 in.)

Data formats

m CD-ROM

m CD-Audio

m CD-R

m CD-RW

m CDI

m CD Bridge

m CD Extended

m CD Mixed Mode

m Photo CD

m Video CD

m DVD-Video

m DVD-ROM

m DVD-R (read only)
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SuperDrive (DVD-R/CD-RW) Specifications

m Disc diameters supported:  12 cm (4.7 in.), 6.75 cm (3 in.)

Data formats

m CD-ROM

m CD-Audio

m CD-R

m CD-RW

m CDI

m CD Bridge

m CD Extended

m CD Mixed Mode

m Photo CD

m Video CD

m non-circular CDs

m DVD-Video

m DVD-ROM

m DVD-R 

USB Specifications 

m Support for USB 1.1

m Four external Universal Serial Bus (USB) Type A ports, two on the rear panel and two on 
the Apple Pro Keyboard.

m Each rear port is on a separate 12 megabit per second (Mbps) USB channel.

m 500 milliamperes (mA) at 5 V are available per port for a total of 1 ampere.

FireWire Specifications 

m Data transfer speed:  100, 200, and 400 Mbps

Power

m Output voltage range:  Approximately 13 to 30 V

m Output power range:  Up to 15 W
 Specifications 61



Ethernet Specifications 

m IEEE 802.3 compliant

m Maximum cable length:  100 meters (m)

m Protocols:  Open Transport, AppleShare, AppleTalk, NetWare for Macintosh, TCP/IP

m Connector:  RJ-45 for 10Base-T, 100Base-TX, and 1000Base-T

m Media, 10Base-T:  Category 3 or higher UTP on 2 pairs up to 100 m

m Media, 100Base-TX:  Category 5 UTP on 2 pairs up to 100 m

m Media, 1000Base-T:  Category 5 and 6 UTP on 4 pairs up to 100 m

m Channel speeds:  IEEE Auto Negotiation of 10Base-T, 100Base-TX, and 1000Base-T

Specifications for the AirPort Card (Optional)

m Wireless data rate:  Up to 11 Mbps

m Range:  Up to 150 feet (data rates may vary depending on environmental conditions)

m Frequency band:  2.4 gigahertz (GHz)

m Radio output power:  15 dBm (nominal)

Compatibility

m 802.11 Direct Sequence Spread Spectrum (DSSS) 1 and 2 Mbps standard

m 802.11 HR DSSS 11 Mbps standard 

Audio Output Specifications 

m Data format 24-bit stereo, 44.1 kilohertz (kHz) audio sample rate

Sound out using the Apple speaker mini-jack

m Power:  8 watts per channel

m Frequency response:  20 hertz (Hz) to 20 kHz 

m Signal-to-noise ratio:  Greater than 90 decibels (dB)

m Total harmonic distortion:  Less than 0.1 percent

m Load:  8 ohm (Ω) 

Sound out using the headphone jack

m Power:  40 milliwatts (mW )

m Frequency response:  40 Hz to 20 kHz 

m Signal-to-noise ratio:  Greater than 96 dB

m Load:  32 Ω 
62 Appendix  A  



Sound output using line-out connector

m Full-scale amplitude:  1.5 volts (root mean square) ( Vrms) for load greater than 1kOhms

m Frequency response:  8 Hz to 20 kHz (load independent)

m Signal-to-noise ratio:  Greater than 100 decibels (dB)

m Total harmonic distortion:  Less than 0.004 percent

Audio Input Specifications

m Data format 24 bits stereo, 44.1 kHz audio sample rate

Line-in specification

m Maximum amplitude:  2 volts (root mean square) ( Vrms)

m Frequency response:  5 Hz to 20 kHz 

m Signal-to-noise ratio:  Greater than 100 dB

m Total harmonic distortion:  Less than 0.005 percent

Graphics Controller

AGP 4X card with an Apple Display Connector (ADC) and Digital Visual Interface (DVI) 
connector.

Video Display Modes

For technical specifications for your display:

m Apple displays:  Go to the Apple website and check the specifications for your product at 
www.apple.com/displays

m Third-party displays:  Go to www.apple.com/guide

Power Supply 

AC line input

m Line voltage/current:  100–120 V alternating current (AC), 6.5 amperes (A) or 200–240 V 
AC, 3.5 A, single phase, set automatically by power supply

m Frequency:  50–60 Hz

DC monitor output

m 4.0 A maximum at nominal 25 V DC from the Apple Display Connector
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Power Supply 

AC line input

m Line voltage/current:  100–120 V alternating current (AC), 6.5 amperes (A) or 200–240 V AC, 
3.5 A, single phase, set automatically by power supply

m Frequency:  50–60 hertz (Hz)

DC monitor output

m 4.0 A maximum at nominal 25 V DC from the Apple Display Connector

Power Requirements for Devices You Can Connect

Expansion cards

m Maximum power consumption by the AGP card is 30 W.

m Maximum power consumption by four PCI cards is 60 W.

USB devices

m Each of the server’s built-in USB ports is allotted 500 mA. 

FireWire devices

m The server can provide up to 15 W total to the FireWire ports.

System Clock and Battery 

m CMOS custom circuitry with long-life lithium battery. You can replace the server’s battery 
(see “Replacing the Battery” on page 53) with a new one purchased from an Apple-
authorized dealer.
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A P P E N D I X

B

B Safety, Maintenance, and Ergonomics

This appendix provides important information about safety procedures, routine 
maintenance, and ergonomic considerations for using your server and display.

Important Safety Information

The only way to disconnect power completely from your server is to unplug the power cord 
from the main power supply. To disconnect your display completely, you must also unplug its 
power cable from the server or power outlet. Make sure at least one end of the device’s 
power cord is within easy reach so that you can unplug the server or display when necessary.

For your own safety and that of your equipment, always take the following precautions.

Disconnect the power plug (by pulling the plug, not the cord), from your server or display if 
any of the following conditions exists:

m The power cord or plug becomes frayed or otherwise damaged

m You spill something into the case

m Your server or display is exposed to rain or any other excess moisture

m Your server or display has been dropped or the case has been otherwise damaged

m You suspect that your server or display needs service or repair

m You want to clean the server or display case or screen 
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To prevent accidents and damage to your server or display, be sure that you always follow 
these instructions:

m Keep your server and display away from sources of liquids and moisture.

m Don’t set anything on top of the server or display.

m Keep the server and display vents free from obstruction.

m Never remove the case from the monitor or open your server when it’s running. You 
could come in contact with hazardous voltage.

Your server is equipped with a three-wire grounding plug—a plug that has a third grounding 
pin. This is a safety feature. Don’t modify the plug to fit into an ungrounded outlet. Contact a 
licensed electrician to replace the outlet with a properly grounded one. Do not defeat the 
purpose of the grounding plug!

Be careful when lifting or moving your server or monitor. Be sure to use correct lifting 
procedures, lifting with your legs. When carrying the monitor, make sure the monitor is 
facing you. Don’t carry the monitor by its stand.

Apple and the Environment

At Apple, we recognize our responsibility to minimize the environmental impacts of our 
operations and products. 

For More Information

Go to www.apple.com/about/environment

Warning  Electrical equipment may be hazardous if misused. Operation of this product 
by children must always be supervised by an adult. Do not allow children access to the 
interior of any electrical product and do not permit them to handle any cables.
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General Maintenance

If you need to clean the server or display beyond wiping it down with a clean cloth, follow 
these instructions:

1 Turn your server and display off.

2 Disconnect the server power cable from the electrical outlet or power strip. If your display is 
connected to an outlet, disconnect it as well.

3 Disconnect the display’s cables from the server.

4 Clean the display screen with soft, lint-free paper or cloth dampened with mild soap and water. 

5 Wipe the server or display case surfaces lightly with a clean, soft cloth dampened with water.

Protecting Your Removable Media Drive

To keep your removable media drive working properly:

m Position your server so that the drive tray doesn’t bump into anything when it opens.

m Close the drive when you’re not using it.

m Do not put anything on the drive tray when it is open.

m Do not touch the optical drive lens with your fingers. Do not wipe the lens with a paper 
towel or other abrasive surface. If you need to clean the lens, see an Apple-authorized 
service provider for a lens cleaner.

m Keep your server away from any source of moisture.

Warning  Do not spray liquid directly onto the display screen. Liquid could drip inside 
the display and cause electrical shock.

Important  Don’t use alcohol, aerosol sprays, solvents, or abrasives that might damage the 
finish on the case.
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Maintaining Your Display

To maintain your display and ensure its long life:

m Do not press on the surface of the display screen.

m Do not write on the screen or touch the screen with a sharp object.

m If you will not be using your display and server for a day or more, turn off the server and 
display or use Energy Saver.

m Turn off your monitor, turn down the brightness, or use a screen saver program that dims 
or varies the image on the screen when the server is idle for a prolonged time. 

Important Ergonomic and Health-Related Information

Here are some guidelines for adjusting the furniture in your office to reduce glare and to 
accommodate your physical size and shape.

m An adjustable chair that provides firm, comfortable support is best. Adjust the height of 
the chair so your thighs are tilted slightly and your feet are flat on the floor. 

The back of the chair should support your lower back (lumbar region). Follow the 
manufacturer’s instructions for adjusting the backrest to fit your body properly.

m When you use the server keyboard, your shoulders should be relaxed. Your upper arm 
and forearm should form an approximate right angle, with your wrist and hand in roughly 
a straight line. 

You may have to raise your chair so your forearms and hands are at the proper angle to 
the keyboard. If this makes it impossible to rest your feet flat on the floor, you can use a 
footrest with adjustable height and tilt to make up for any gap between the floor and your 
feet. Or you can lower the desktop to eliminate the need for a footrest. Another option is 
to use a desk with a keyboard tray that’s lower than the regular work surface.

m Position the mouse at the same height as your keyboard. Allow adequate space to use the 
mouse comfortably.

m Arrange the monitor so the top of the screen is slightly below your eye level when you’re 
sitting at the keyboard. The best distance from your eyes to the screen is up to you, 
although most people seem to prefer 18 to 28 inches (45 to 70 cm). 
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m Position the monitor to minimize glare and reflections on the screen from overhead lights 
and nearby windows. If possible, use a tiltable monitor stand. The stand lets you set the 
monitor at the best angle for viewing, helping to reduce or eliminate glare from lighting 
sources you can’t move.

For more information about health, safety, and maintenance, go to Apple’s 
website:  www.apple.com/about/ergonomics

Thighs tilted slightly

Shoulders relaxed

Screen positioned to avoid
reflected glare

Forearms and hands
in a straight line

Forearms level
or tilted slightly

Lower back supported

Feet flat on the floor

Top of the screen at or slightly
below eye level (You may need
to adjust the height of your
display by placing something
under it or by raising your
work surface.)

Clearance under work surface

45–70 cm (18–28 in.)
 Safety, Maintenance, and Ergonomics 69



70 Communications, Telephone, and Modem Regulation Information  

Communications, Telephone, and Modem Regulation Information 

For information on FCC regulations, radio and television interference, and telephone and modem information 
related to this product, see the files in the Communications Regulations folder, inside the Documents folder on 
your hard disk.

Laser Information

Warning  Making adjustments or performing procedures other than those specified in your equipment’s 
manual may result in hazardous radiation exposure.

Do not attempt to disassemble the cabinet containing the laser. The laser beam used in this product is harmful to 
the eyes. The use of optical instruments, such as magnifying lenses, with this product increases the potential 
hazard to your eyes. For your safety, have this equipment serviced only by an Apple-authorized service provider. 

If you have an internal Apple CD-ROM, DVD-ROM, or DVD-RAM drive in your computer, your computer is a Class 
1 laser product. The Class 1 label, located in a user-accessible area, indicates that the drive meets minimum safety 
requirements. A service warning label is located in a service-accessible area. The labels on your product may differ 
slightly from the ones shown here. 

Laser Specifications

Laser on pickup unit (when reading a CD):

m Type:  Semiconductor GaAlAs laser

m Wavelength:  790 nm

m Power out of objective lens:  3.3 mW

m Beam divergence:  horizontal 12º vertical 35º

Exposure to Radio Frequency Energy

The radiated output power of the optional AirPort Card is far below the FCC radio frequency exposure limits. 
Nevertheless, it is advised to use the wireless equipment in such a manner that the potential for human contact 
during normal operation is minimized.

Mouse and Keyboard Information

The Apple optical mouse is a Class 1 LED product. This product complies with the requirements of European 
Directives 72/23/EEC and 89/336/EEC.

It also complies with the Canadian ICES-003 Class B Specification.

High-Risk Activities Warning

This computer system is not intended for use in the operation of nuclear facilities, aircraft navigation or 
communications systems, or air traffic control machines, or for any other uses where the failure of the computer 
system could lead to death, personal injury or severe environmental damage.

Class 1 label Service warning label
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